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Document Introduction
This document is intended for persons who upgrade software for FX Supervisory Controllers.
This document describes FX Supervisory Controller documentation and controller concepts. It
describes the detailed procedures for upgrading FX Workbench 6.x and earlier and the steps for
migrating to FX Supervisory Software 14.x.

Concepts
FX Supervisory Controllers
FX Supervisory Controllers describe a family of hardware products. The FX80 is the only actively
manufactured controller and it is recommended to use in every new installation. The FX20, FX40,
FX60 are all no longer available to order and it is recommended they be replaced with an FX80.
The FX30, FX60E, and FX70 have been discontinued and while they still are available to order, it's
recommended that an FX80 is ordered instead. FX Supervisory Controllers provide the following
capabilities:

• Field bus, network-level integration of devices (such as HVAC equipment controllers, lighting
panels, and variable frequency drives).

• Direct integration of inputs and outputs (such as energy meters, alarm indicators, temperature
sensors, and actuators).

• Field bus, network-level automation and coordination through scheduling, alarming, trending,
and customized control logic (such as runtime totalization, energy management, interlocking,
staging/sequencing, and PID control).

• Web-based, graphical user interface that supports both local and remote access.

FX Server
The FX Server software product is available for various computer platforms and provides:

• Network integration of two or more Facility Explorer 6.x and earlier, or one or more for Facility
Explorer 14, FX Supervisory Controllers, or IP-based devices (without any FX Supervisory
Controllers).

• Network-wide automation and coordination for one or more FX Supervisory Controllers through
master scheduling, and centralized, long-term, high-capacity storage of alarms and trends.

• Centralized, network-wide, web-based, graphical user interface for one or more FX Supervisory
Controllers supporting both local and remote access.

(Release 6.x) FX Supervisor Controller Family Software DVD (LP-
FXWB-COPY)
The FX Supervisor Controller Family Software DVD includes a suite of software tools and
applications used to configure, commission, and interact with FX Supervisory Controllers. The FX
Supervisory DVD includes:

• FX Workbench and FX Server: this tool is used to configure and commission FX Supervisory
Controllers using the Johnson Controls® configuration appliance.
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• FX Workbench Pro: this tool is used to configure and commission FX Supervisory Controllers
using both the Johnson Controls configuration appliance and the NiagaraAX™ Workbench.

• FX Alarm Portal: this application provides an alarm monitoring workstation.

• LX Wizards: the Support Pack, Configuration, and LX Smart Installer, are collections of
executable files that let you configure a LON network and program LX controllers.

You can license FX Workbench/FX Workbench Pro using one of two ordering codes:

• End-User Version (FX-SL001M1-0).

• Engineering/Demo Version (FX-SLDEMO-0).

Table 1: Comparison of FX Tools Supervisory Pro Versions

Feature End-User Version (FX-
SL001M1-0)

Engineering/Demo
Version (FX-SLDEMO-0)

Allows users to connect to and interact
with FX Supervisory Controllers

Yes Yes

Allows users to reconfigure existing
stations while online

Yes Yes

Allows users to back up and restore
stations

Yes Yes

Allows users to create new stations
while offline

No Yes

Expiration Policy Never expires Expires every October
31

Intended user type Facility operations personnel Installing contractors

FX Alarm Portal Client
FX Alarm Portal Client (LP-FXWBALM-0) provides the FX Alarm Portal functionality only. FX Alarm
Portal Client includes no FX Workbench or FX Workbench Pro functionality.

Upgrading
Upgrading is the process of installing new software onto your computer, onto an FX Supervisory
Controller, or both.

Migration
Migration is similar to upgrading, but signifies a larger change in software. Migration typically
requires more steps and conversions to move forward.

Upgrade Pricing Policy
You can purchase software new or you can purchase maintenance for software. Maintenance can
be purchased in 1, 3, or 5-year increments. With each maintenance plan, you have access to any
new software developed during that time. If you let the maintenance lapse, and want it later, you
must buy the maintenance you missed plus the new maintenance.
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Software Revision Numbering
All FX Supervisory Controller, FX Server, and FX Tools Supervisor Pro software products incorporate
an instance of Niagara software. See the following table to find which revision of the Niagara
software is used in each FX Supervisory software release.
Major Upgrades
Major upgrades typically contain new features, significant enhancements, and bug fixes. Major
upgrades are identified by changes to the major revision number of the software. For example, 2.0
is a major upgrade to 1.2.
Minor Upgrades
Minor upgrades typically contain bug fixes or small enhancements. Minor upgrades are identified
by changes to the minor revision number of the software. For example, 1.2 is a minor upgrade to
1.1.
Table 2: Niagara Version Used

SR Key Identifying Features or
Changes

Niagara
Software
Versions

FX20 FX30E FX40 FX60 FX60E FX70 FX80

1.0 Initial release that introduced
the FX40 Supervisory
Controller, FX Server, and FX
Tools Supervisor Pro.

3.0.88 NA NA X NA NA NA NA

1.1 Minor release that introduced
the update to the N2 Device
Manager, corrections to the
Variable Air Volume (VAV)
Modular Assembly (VMA)
occupancy enumerations, and
other minor bug fixes.

3.0.99 NA NA X NA NA NA NA

1.2 Minor release that introduced
several enhancements and
bug fixes, including a new
tabbed structured system
graphic template, new
Schedule, Point Group, and
Link Managers, and FX Alarm
Portal.

3.0.106 NA NA X NA NA NA NA

2.0 Major release that introduced
the FX20 and FX60
Supervisory Controllers and
accessories, FX Server Limited,
FX Server driver options, FX
Alarm Portal client, and bug
fixes to the N2 driver.

3.3.22 X NA X X NA NA NA

2.1 Minor release that introduced
the Wireless TEC Option card,
LX Series LON Controller
configuration wizards, a New
Station wizard, and the Global
Point Extension Manager.

3.3.31 X NA X X NA NA NA
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Table 2: Niagara Version Used

SR Key Identifying Features or
Changes

Niagara
Software
Versions

FX20 FX30E FX40 FX60 FX60E FX70 FX80

2.2 Minor release that introduced
support for iPhone® interface
or a similar sized graphical
user interface and the Point
Order field to the System
Library.

3.3.31 X NA NA X NA NA NA

3.0 Major release that introduced
the FX22, FX62, and FX70
Supervisory Controllers and
accessories, FXRIO Remote
Input/Output (I/O) Module,
and General Packet Radio
Service (GPRS) Modem option
card.

3.5.25 X NA NA X NA X NA

3.1 Minor release that introduced
the Assisted Device Import
feature, which supports the
new FX-PC Programmable
Controllers.

3.5.34 X NA NA X NA X NA

4.0 Major release that introduced
the FX20, FX60, and FX70
Supervisory Controllers with
factory-installed BACnet® MS/
TP protocol driver licenses,
additional option cards, FX
Energy Suite, and FX20/FX60
basic demo supervisory
controllers.

3.6.31 X NA NA X X X NA

4.1 Minor release that introduced
FX Server changes, BTL
Certification, and changes to
the method of FX Supervisor
Controller family software
delivery and licensing.

3.6.47 X NA NA X X X NA

4.1 Patch release 3.6.407 X NA NA X X X

5.0 Major release that introduced
revised graphic images and
templates, N2 device convert
manager, and new wizard
service for LX controllers.

3.7.106 X X NA X X X NA
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Table 2: Niagara Version Used

SR Key Identifying Features or
Changes

Niagara
Software
Versions

FX20 FX30E FX40 FX60 FX60E FX70 FX80

5.1 Minor release that introduced
updates to FX Workbench.
These updates include Batch
Import, Simple Plant Standard
Graphics, Point Summary
Manager, Hardware Scan
Service, Graphic Sizing
Selection for Mobile Devices,
and Launch FX-PCT.

3.7.106 X X NA X X X NA

5.2 Minor release that introduced
the FX30E and FX60E
Supervisory Controllers. Also
introduced were updates
to tuning polices in FX
Workbench, N2 Help, and
Zoning application graphics.

3.7.106 X X NA X X X NA

5.3 Patch release 3.7.108 X X NA X X X NA
6.0 Major release that allows FX

Workbench to run on the
Niagara 3.8 platform.

3.8.38 NA X NA X X X NA

6.1 Minor release that introduced
updates to FX Workbench.
These updates include Spaces
and Equipment, Meters,
WT4000, and updates to the
Point Summary Manager.

3.8.38 NA X NA X X X NA

6.2 Patch release 3.8.41 NA X NA X X X NA
6.3 Minor release that introduced

updates to FX Workbench.
These updates include
support for the FX80,
Java® Web Start, support
for Windows® 10, and an
improved system usability.

3.8.111 NA NR NA X X X X

6.4 Patch release 3.8.213 NA NR NA X X X X
6.5 Patch release 3.8.311 NA NR NA X X X X
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Table 2: Niagara Version Used

SR Key Identifying Features or
Changes

Niagara
Software
Versions

FX20 FX30E FX40 FX60 FX60E FX70 FX80

6.6 Minor release that provides
four functional fixes: a new
system property that allows
extending the timeout on
platform connection, a fix for
CCN Numeric override never
stops writing, certificates
can now be approved for TLS
connections from WebStart
and the weather service can
now follow URI redirects

3.8.401 NA NR NA X X X X

14.0 Major release that allows FX
Workbench to run on the
Niagara 4 platform.

The jump from 6.x to 14.x
was intentional to align with
the Niagara software version
moving forward.

4.0.22.16 NA NR NA X X X NA

14.1 Minor release that adds
support for FX80 Supervisory
Controllers

4.1.27.20 NA NR NA X X X X

14.2 Minor release that adds
Analytics 2.0 to FX Workbench.
There is also support for
Linux® operating system, the
Alarm Portal, more robust
FX Server data management
features, and support for FX80
legacy drivers.

4.2.36.38 NA NR NA X X X X

14.3 Minor release that introduced
two new RIO modules. The
release also adds new HTML5
screens to FX Workbench and
improved mobile web device
functionality.

4.3.58.18 NA NR NA X X X X
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Table 2: Niagara Version Used

SR Key Identifying Features or
Changes

Niagara
Software
Versions

FX20 FX30E FX40 FX60 FX60E FX70 FX80

14.4 Minor release adding
new HTML5 screens to FX
Workbench, improving mobile
web device functionality.
Minor change to the User
Service making the scheduled
access for users available
through the User Details
section. The JCI User manager
has been removed. Updating
an existing Nav file is through
the Tools menu.

4.4.73.6 NA NR NA X X X X

14.4
U1

Minor release that provides
eighteen functional fixes.
These included updated
firmware to solve FX80
WIFI modem failure, a fix
to Niagara Daemon Engine
Watchdog, and fixes to
lexicons, hyperlinking,
scrolling, and adding notes.

There was also
internationalization fixes to
lexicons and locales along
with web fixes to PDF Export,
Webchart, popups, PxIncludes
and HTML5 property sheets.

4.4.92.2 NA NR NA X X X X

14.6 Minor release that provides
a number of updates and
fixes. These include Auto
Export, a feature only
available on Facility Explorer®,
cybersecurity fixes and a
mobile refresh update.

4.6.96.28 NA NR NA X

14.7 Minor release that provides
new provisioning steps
for common processes, a
new template type called
'Application Templates', and
a secondary JACE port that
supports the DHCP server.

4.7.109.2
0.3

NA NR NA X
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Table 2: Niagara Version Used

SR Key Identifying Features or
Changes

Niagara
Software
Versions

FX20 FX30E FX40 FX60 FX60E FX70 FX80

14.7.
x

Minor release that provides a
number of new FX features.
These include extending
14.7 with automatic meta-
data tagging of applications,
a HTML5-based Point-
Extension-Manager, point
groups and a point-group-
manager driven by data tags,
and the launch of CCT 13.0,
replacing PCT.

4.7.109.2
0.3

NA NR NA X

Note: NR stands for Not Recommended and SR stands for Software Release.

Note: Based on poor performance observed under lab conditions, we do not recommend that
you use the FX30E with software release 6.3 or any subsequent software release.

Note: 14.4 is the final 14.x release that supports the FX30E, FX60E, and FX70. After 14.4, the
14.x releases will only support the FX80.

Software License Agreement
All Johnson Controls software is licensed. During the installation process, you must accept or
decline the terms of the software licensing agreement.

Preventing Unauthorized Software Duplication or Usage
Johnson Controls, Inc. uses the following two methods to prevent unauthorized software
duplication and usage.

• Acceptance of the terms of the software licensing agreement legally prohibits duplicating or
using Johnson Controls Facility Explorer software tools without authorization. This method
applies to all Johnson Controls Facility Explorer software.

• A properly formatted and installed license file (FacExp.license) is required to enable the operation
of FX Workbench, FX Workbench Pro, FX Alarm Portal, and FX Server.

Note: At Release 14.0 and later, a new Johnson.license is required to enable the operation of
the N2 driver.

License Files
License files are required to enable operation of FX Supervisory Controllers, FX Server, and FX
Tools Supervisor Pro. License files are keyed to the host ID. A host ID is unique to each hardware
platform.

• Host IDs that begin with Win- are targeted to computers.

• Host IDs that begin with Qnx- are targeted to FX Supervisory Controller.
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A license file is a text file (FacExp.license) that you can read but not edit. License files contain a digital
signature, and any attempt to edit them renders the files invalid.
Included in each license file is a list of features allowed to operate inside the host device. These
features may include network drivers, database drivers, the maximum number of devices allowed,
the maximum number of points allowed, tool profiles, and other feature options.
Also included in each license file is the version of Niagara software allowed to operate inside the
host device. When upgrading software in a host (computer or FX Supervisory Controller), the license
version must be equal to or greater than the software version.

NiagaraAX and Niagara 4 licenses are two different files. Make sure that you have the correct
license for the Niagara version you are using. NiagaraAX licenses do not work on Niagara 4, and
Niagara 4 licenses do not work on NiagaraAX.
Also, if you are emailed the licenses, the Niagara 4 .zip file also contains the Johnson.license for N2.

Part Numbers
The following table provides and compares the part numbers for both FX Supervisory Software 6.x
Product Code and FX Supervisory Software 14.x Product Code.
Table 3: Product Code Conversion Table

FX Supervisory
Software 6.x

Description FX Supervisory
Software 14.x

Description

NA NA FX-SL000M1-0 FX Server with no network
connection. For use with
TCP/IP. Includes 1-year
software maintenance.

NA NA FX-SL000M3-0 FX Server with no network
connection. For use with
TCP/IP. Includes 3-year
software maintenance.

NA NA FX-SL000M5-0 FX Server with no network
connection. For use with
TCP/IP. Includes 5-year
software maintenance.

LP-FXWBE-0 License enabling the
end user version of FX
Workbench client software.
Enables those features
needed to operate and re-
configure FX Supervisory
Controllers and FX Server
stations only via an online
connection (cannot create
new stations offline).
Intended for end users
(operators). Never expires.
Order (LP-FXWB-COPY)
or download software
separately.

FX-SL001M1-0 FX Server with one
network connection. Client
Workbench. Includes 1-year
software maintenance.
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Table 3: Product Code Conversion Table

FX Supervisory
Software 6.x

Description FX Supervisory
Software 14.x

Description

NA NA FX-SL001M3-0 FX Server with one
network connection. Client
Workbench. Includes 3-year
software maintenance.

NA NA FX-SL001M5-0 FX Server with one
network connection. Client
Workbench. Includes 5-year
software maintenance.

NA NA FX-SL002M1-0 FX Server with two network
connections. Includes 1-year
software maintenance.

NA NA FX-SL002M3-0 FX Server with two network
connections. Includes 3-year
software maintenance.

NA NA FX-SL002M5-0 FX Server with two network
connections. Includes 5-year
software maintenance.

LP-FXWS-3 License enabling 3-device FX
Server. Allows integration of
up to three FX Supervisory
Controllers. Supports 32-bit
or 64-bit Windows computer
platforms. Includes Niagara
Historical Database, FX
Workbench, Niagara driver,
and oBix client/server driver
(only for connecting to
Niagara-based controllers).
Order (LP-FXWB-COPY)
or download software
separately.

FX-SL003M1-0 FX Server with three network
connections. Includes 1-year
software maintenance.

NA NA FX-SL003M3-0 FX Server with three network
connections. Includes 3-year
software maintenance.

NA NA FX-SL003M5-0 FX Server with three network
connections. Includes 5-year
software maintenance.

NA NA FX-SL010M1-0 FX Server with 10 network
connections. Includes 1-year
software maintenance.

NA NA FX-SL010M3-0 FX Server with 10 network
connections. Includes 3-year
software maintenance.
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Table 3: Product Code Conversion Table

FX Supervisory
Software 6.x

Description FX Supervisory
Software 14.x

Description

NA NA FX-SL010M5-0 FX Server with 10 network
connections. Includes 5-year
software maintenance.

LP-FXWS-100 License enabling 100-device
FX Server. Allows integration
of up to 100 FX Supervisory
Controllers. Supports 32-bit
or 64-bit Windows computer
platforms. Includes Niagara
Historical Database, FX
Workbench, Niagara driver,
and oBix client/server driver
(only for connecting to
Niagara-based controllers).
Order (LP-FXWB-COPY)
or download software
separately.

FX-SL100M1-0 FX Server with 100 network
connections. Includes 1-year
software maintenance.

NA NA FX-SL100M3-0 FX Server with 100 network
connections. Includes 3-year
software maintenance.

NA NA FX-SL100M5-0 FX Server with 100 network
connections. Includes 5-year
software maintenance.

LP-FXWS-UNL License enabling
unrestricted FX Server.
Allows integration of an
unrestricted number of FX
Supervisory Controllers
(actual number of FX
Supervisory Controllers
will be limited only by the
power of the host computer
platform) Supports 32-bit or
64-bit Windows computer
platforms. Includes Niagara
Historical Database, FX
Workbench, Niagara driver,
and oBix client/server driver
(only for connecting to
Niagara-based controllers).
Order (LP-FXWB-COPY)
or download software
separately.

FX-SLUNLM1-0 FX Server with unlimited
network connections.
Includes 1-year software
maintenance.
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Table 3: Product Code Conversion Table

FX Supervisory
Software 6.x

Description FX Supervisory
Software 14.x

Description

NA NA FX-SLUNLM3-0 FX Server with unlimited
network connections.
Includes 3-year software
maintenance.

NA NA FX-SLUNLM5-0 FX Server with unlimited
network connections.
Includes 5-year software
maintenance.

LP-FXSWUPG-0 License file enabling a one-
time software upgrade for
one copy of FX Server or 1
copy of FX Workbench-End
User Version or 1 copy of FX
Alarm Portal

FX-SL000M1-6 FX Server no upgrade.
Includes 1-year software
maintenance

NA NA FX-SL000M3-6 FX Server no upgrade.
Includes 3-year software
maintenance

NA NA FX-SL000M5-6 FX Server no upgrade.
Includes 5-year software
maintenance.

NA NA FX-SL001M1-6 FX Server one upgrade.
Includes 1-year software
maintenance.

NA NA FX-SL001M3-6 FX Server one upgrade.
Includes 3-year software
maintenance.

NA NA FX-SL001M5-6 FX Server one upgrade.
Includes 5-year software
maintenance.

NA NA FX-SL002M1-6 FX Server two upgrade.
Includes 1-year software
maintenance.

NA NA FX-SL002M3-6 FX Server two upgrade.
Includes 3-year software
maintenance.

NA NA FX-SL002M5-6 FX Server two upgrade.
Includes 5-year software
maintenance.

NA NA FX-SL003M1-6 FX Server three upgrade.
Includes 1-year software
maintenance.

NA NA FX-SL003M3-6 FX Server three upgrade.
Includes 3 year software
maintenance.
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Table 3: Product Code Conversion Table

FX Supervisory
Software 6.x

Description FX Supervisory
Software 14.x

Description

NA NA FX-SL003M5-6 FX Server three upgrade.
Includes 5-year software
maintenance.

NA NA FX-SL010M1-6 FX Server 10 upgrade.
Includes 1-year software
maintenance.

NA NA FX-SL010M3-6 FX Server 10 upgrade.
Includes 3-year software
maintenance.

NA NA FX-SL010M5-6 FX Server 10 upgrade.
Includes 5-year software
maintenance.

NA NA FX-SL100M1-6 FX Server 100 upgrade.
Includes 1-year software
maintenance.

NA NA FX-SL100M3-6 FX Server 100 upgrade.
Includes 3-year software
maintenance.

NA NA FX-SL100M5-6 FX Server 100 upgrade.
Includes 5-year software
maintenance.

NA NA FX-SLUNLM1-6 FX Server unlimited upgrade.
Includes 1-year software
maintenance.

NA NA FX-SLUNLM3-6 FX Server unlimited upgrade.
Includes 3-year software
maintenance.

NA NA FX-SLUNLM5-6 FX Server unlimited upgrade.
Includes 5-year software
maintenance.

LP-FXWBDEM-0 License enabling the
Engineering/Demo
version of FX Workbench
client software: Enables
all features needed to
engineer or demonstrate
FX Supervisory Controllers
and FX Server Stations.
Intended for installing
contractors. Requires annual
support fee. Expires yearly.
Order (LP-FXWB-COPY)
or download software
separately.

FX-SLDEMO-0 FX Server Demo
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Table 3: Product Code Conversion Table

FX Supervisory
Software 6.x

Description FX Supervisory
Software 14.x

Description

NA NA FX-SLU001-6 FX Server additional one
network upgrade

LP-FXWSU-100 License update to convert
a three-device FX Server
license to a 100-device FX
Server license

FX-SLU100-6 FX Server 100 network
upgrade

LP-FXWSU-UNL License update to convert a
100-device FX Server license
to an unrestricted FX Server
license

FX-SLUUNL-6 FX Server unlimited network
upgrade

NA NA FX-SLDL010-0 FX Server 10 IP device license
NA NA FX-SLDL025-0 FX Server 25 IP device license
NA NA FX-SLDL050-0 FX Server 50 IP device license
NA NA FX-SLDL100-0 FX Server 100 IP device

license
NA NA FX-SLDL200-0 FX Server 200 IP device

license
LP-FXWSBACC-0 License enabling the

BACnet/IP client driver (first
500 points) for one FX Server

NA All BACnet Drivers come
with purchase of FX Server.
Device license is required
for each TCP/IP device being
managed.

LP-FXWSBACS-0 License enabling the
BACnet/IP server driver (first
500 points) for one FX Server

NA All BACnet Drivers come
with purchase of FX Server.
Device license is required
for each TCP/IP device being
managed.

LP-FXWSBACCS-0 License enabling
combination of the BACnet/
IP client and server driver
(first 500 points) for one FX
Server.

Note: Adding B-AWS or
B-OWS to this license
invalidates the BTL
listing.

NA All BACnet Drivers come
with purchase of FX Server.
Device license is required
for each TCP/IP device being
managed.

LP-
FXWSBACSU-0

License to add the BACnet/
IP server driver to an FX
Server that has already been
licensed with the BACnet/IP
client driver

NA All BACnet Drivers come
with purchase of FX Server.
Device license is required
for each TCP/IP device being
managed.
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Table 3: Product Code Conversion Table

FX Supervisory
Software 6.x

Description FX Supervisory
Software 14.x

Description

LP-
FXWSBACCU-0

License to add the BACnet/
IP server driver to an FX
Server that has already been
licensed with the BACnet/IP
client driver

NA All BACnet Drivers come
with purchase of FX Server.
Device license is required
for each TCP/IP device being
managed.

LP-FXWSBAC5-0 License enabling 500
additional BACnet/IP points
for one FX Server

NA All BACnet Drivers come
with purchase of FX Server.
Device license is required
for each TCP/IP device being
managed.

LP-
FXWSBACOW-0

License enabling the BACnet
Operator Workstation (B-
OWS) for one FX Server
(requires the BACnet/IP
client driver)

NA FX Server 14.x is not BTL
listed.

LP-
FXWSBACAW-0

License enabling the
BACnet Advanced Operator
Workstation (B-AWS) for
one FX Server (requires the
BACnet/IP client driver)

NA FX Server 14.x is not BTL
listed.

LP-
FXWSBACAWU-0

License to upgrade a BACnet
Operator Workstation

(B-OWS) to a BACnet
Advanced Operator
Workstation (B-AWS)

NA FX Server 14.x is not BTL
listed.

LP-FXWSMDB-0 License enabling Modbus
TCP client driver (500 points)
for one FX Server

NA All Modbus Drivers come
with purchase of FX Server.
Device license is required
for each TCP/IP device being
managed.

LP-FXWSMDB5-0 License enabling 500
additional Modbus TCP
client driver points for one
FX Server

NA All Modbus Drivers come
with purchase of FX Server.
Device license is required
for each TCP/IP device being
managed.

LP-FXWSMDBS-0 License enabling Modbus
TCP subordinate driver
(first 500 points) for one FX
Server. Enables FX Server
to serve its data to Modbus
master devices over a
Modbus TCP connection.

NA All Modbus Drivers come
with purchase of FX Server.
Device license is required
for each TCP/IP device being
managed.
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Table 3: Product Code Conversion Table

FX Supervisory
Software 6.x

Description FX Supervisory
Software 14.x

Description

LP-
FXWSMDBS5-0

License enabling 500
additional Modbus TCP
subordinate driver points
for one FX Server

NA All Modbus Drivers come
with purchase of FX Server.
Device license is required
for each TCP/IP device being
managed.

LP-FXWSOPC-0 License enabling OPC driver
(500 points) for one FX
Server

NA NA

LP-FXWSOPC5-0 License enabling 500
additional OPC points for
one FX Server

NA NA

LP-FXWSOBX-0 License enabling oBix driver
(500 points) for one FX
Server

NA NA

LP-FXWSOBX5-0 License enabling 500
additional oBix points for
one FX Server

NA NA

LP-FXWSSNMP-0 License enabling SNMP
driver (500 points) for one
FX Server

NA All SNMP Drivers come
with purchase of FX Server.
Device license is required
for each TCP/IP device being
managed.

LP-
FXWSSNMP5-0

License enabling 500
additional SNMP points for
one FX Server

NA All SNMP Drivers come
with purchase of FX Server.
Device license is required
for each TCP/IP device being
managed.

NA NA FX-SLMYSQL-0 FX Server MYSQL license
LP-FXWSORCL-0 License enabling Oracle

database driver for one FX
Server

FX-SLORCL-0 FX Server Oracle license

LP-FXWSSQL-0 License enabling SQL
database driver for one FX
Server

FX-SLSQL-0 FX Server SQL license

LP-FXWSCSV-0 License enabling *.xls
and *.csv file data to be
imported into one FX Server

FX-SLCSV-0 FX Server CSV license

LP-FXWSOPC-0 License enabling OPC driver
(500 points) for one FX
Server

FX-SLOPCCL-0 FX Server OPC client license

LP-FXWSDB2-0 License enabling IBM DB2
database driver for one FX
Server

NA NA
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Table 3: Product Code Conversion Table

FX Supervisory
Software 6.x

Description FX Supervisory
Software 14.x

Description

LP-FXESTA-0 License enabling FX Energy
to analyze data from one
FX Supervisory controller or
station. Analyzes as many
points as the designated FX
Supervisory controller can
support. Can be combined
with point licenses (LP-
FXEPN) as required to
complete a solution.

NA NA

LP-FXEPNT-0 License enabling FX Energy
to analyze a single point of
data. Analyzes a single point
from an FX Supervisory
controller or station, an
instance of Niagara, a meter
or a database point. Can
be combined with station
licenses (LP-FXESTA) as
required to complete a
solution.

NA NA

LP-FXWSSADR-0 License enabling the Simple
OpenADR software driver
for one FX Server. Allows
communication to the
Akuacom DRAS. Limited to
one DRAS client connection
to the DRAS. Includes a
CRYPTO license for the SSL
connection.

NA NA

LP-FXWSSADR1-0 License enabling one
additional DRAS client server
connection. The FX Server
must already contain part
number LP-FXWSSADR-0.

NA NA

LP-FXWBALM-0 License enabling FX Alarm
Portal Client software.
Enables only FX Alarm Portal
and Alarm Console features.
Intended for end users.
Never expires. Order (LP-
FXWB-COPY) or download
software separately.

NA NA
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Table 3: Product Code Conversion Table

FX Supervisory
Software 6.x

Description FX Supervisory
Software 14.x

Description

LP-FXLICCH-0 License change fee to
transfer end-user license
from one computer’s host ID
to another.

NA NA

LP-FX40UPG-0 License enabling a one-time
software upgrade for one
FX20/FX40/FX60/FX70

FX-SC3EM1-6 FX30E software 1-year
maintenance upgrade.

NA NA FX-SC3EM3-6 FX30E software 3-year
maintenance upgrade.

NA NA FX-SC3EM5-6 FX30E software 5-year
maintenance upgrade.

LP-FX40UPG-0 License enabling a one-time
software upgrade for one
FX20/FX40/FX60/FX70

FX-SC6EM1-6 FX60E software 1-year
maintenance upgrade.

NA NA FX-SC6EM3-6 FX60E software 3-year
maintenance upgrade.

NA NA FX-SC6EM5-6 FX60E software 5-year
maintenance upgrade.

LP-FX40UPG-0 License enabling a one-time
software upgrade for one
FX20/FX40/FX60/FX70

FX-SC7M1-6 FX70 software 1-year
maintenance upgrade.

NA NA FX-SC7M3-6 FX70 software 3-year
maintenance upgrade.

NA NA FX-SC7M5-6 FX70 software 5-year
maintenance upgrade.

NA NA FX-SC8M1-6 FX80 software 1-year
maintenance upgrade.

NA NA FX-SC8M3-6 FX80 software 3-year
maintenance upgrade.

NA NA FX-SC8M5-6 FX80 software 5-year
maintenance upgrade.

LP-FXWB-COPY FX Supervisory Controller
family software, delivered
on DVD. Contains
installation images for
FX Server, FX Workbench,
and FX Alarm Portal Client.
Licenses not included. Order
licenses separately.

FX-DVD-COPY FX Supervisory Controller
family software, delivered
on DVD. Contains latest
installation images for
FX Server, FX Workbench,
and FX Alarm Portal Client.
Licenses not included. Order
licenses separately.
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Detailed Procedures for Upgrading FX Workbench
6.x and Earlier

Note:  If you are using Facility Explorer 5.x or earlier and want to migrate to Facility Explorer
14, you must purchase the upgrade part to move to Facility Explorer 6.x before you move
to Facility Explorer 14.x. To migrate to Facility Explorer 14.x, see Detailed Procedures for
Migrating to FX Supervisory Software 14.x.

This section describes how to back up your FX Supervisory Controller and prepare it gor upgrading.
It also provides detailed instructions on how to upgrade FX Workbench, re-license the FX
Supervisory Controller, and install new software into the FX Supervisory Controller.

Backing Up Your FX Supervisory Controller Station
1. Expand the Nav tree for the station you want to back up.

2. In the Nav tree, expand Platform.

3. Double-click Station Copier.

4. Select the station that you want to copy from the Stations on panel.

5. Click Copy.

6. Enter a name for the Station name and click Next.

7. Select Copy every file in the station directory and its subdirectories and click Next.

Table 4: Transferring Station Copy Options

Feature Description
Copy files from selected directories Allows you to select individual files to copy

and transfer
Copy every file in the station directory and its
subdirectories

Copies all files for transfer (recommended
for backing up a remote station during this
upgrade procedure)

Copy only the config.bog station database file Copies the station database only (for
example, drivers, devices, and points) and no
associated files

8. Click Next. The station is stopped.

9. Verify that the transfer information is correct and click Finish. The station files are transferred
to your computer. When the transfer is complete, the Save station and Transfer files indicators
turn green, and the last entry in the Transferring station window states Transfer complete

10. Click Close. The remote station is now backed up to your computer.

Preparing Your FX Supervisory Controller for Upgrading
Upgrading FX Supervisory Controllers typically requires additional memory.

Note:
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• You must make sure your FX Supervisory Controller has an adequate amount of memory
before you attempt the upgrade. If you attempt to upgrade an FX Supervisory Controller
that does not have enough memory, the upgrade procedure fails and your FX Supervisory
Controller may become unrecoverable.

•  Do not attempt to upgrade an FX40 (with standard memory, 128 MB RAM, 31 MB flash) to
version 2.2 or higher. The FX40 does not have enough memory to support this upgrade.

•  Do not attempt to upgrade an FX20 to Release 5.0 if the /ffs0 partition is less than 5.0 MB
of file space. To see how much free file space is available, open the Platform\Platform
Administration view and note how much file space is free. If there is less than 5.0 MB free,
we do not recommend that you upgrade to FX20 (1024 KB = 1 MB. 5120 KB = 5 MB).

Checking for Minimum Memory Requirements
1. Start FX Workbench by clicking Start > Programs > FX Tools Supervisor Pro-x.x > FX Workbench.

2. Connect to the FX Supervisory Controller by selecting File > Open Remote Station and entering
the IP address and platform and station login credentials.

3. In the Navigation sidebar, expand Administration, double-click Platform, and verify the file
system (/ffs0) has the minimum memory requirements identified in Table 5. If it does not, see
Troubleshooting the File Too Large Error Message before continuing with this upgrade.

Table 5: Approximate Memory Requirements for Upgrading

Feature Description
From 1.2 to 2.0 3072 KB (3.0 MB)
From 1.2 to 3.0 Not recommended
From 2.0 or 2.1 to 3.0 10,000 KB (10 MB)
From 2.2 to 3.0 5,000 KB (5 MB)
From 3.0 to 4.1 5,000 KB (5 MB)
From 4.1 to 5.0 5,000 KB (5 MB)

4. If your FX Supervisory Controller does not contain the minimum memory requirements, then
delete unused files to increase the file space. Some files that are likely unused are the Graphic
Templates stored in the sysGraphicsFile, sysGraphicsFileHx, sysPxFile, and sysPxFileHx folders.

Note:  If you delete all the unused files and the minimum required free space is still not
available, the FX Supervisory Controller cannot be upgraded.

Upgrading the FX Workbench Software
You use FX Workbench to upgrade the FX Supervisory Controller. Therefore, you must upgrade your
FX Workbench software before you can upgrade your FX Supervisory Controller.

1. Email a request to software.manufacturing@jci.com for an upgraded license to your FX
Workbench. In your email, please provide your host ID (Win-####).

Note:  If your FX Workbench software is not currently part of a software maintenance
agreement, you need to order a software upgrade. Include your purchase order number
on the same email.

2. Receive the upgraded FX Workbench software license, unzip it, and paste it into the licenses
folder (FXWorkbench-6.x\locenses or FXWorkbench-14.x\security\licenses).
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3. Obtain the most recent version of FX Workbench by ordering LP-FXWB-COPY or FX-DVD-COPY
(for 14.x) or by downloading it from the Pro FX User Connected Community.

4. Receive the CD.
Note:  The license file you obtained in Step 2 should be automatically copied from your
previous installation directory and pasted into the licenses folder of your new installation
directory. If not, copy and paste it there.

5. Run the software by clicking Start > Programs > FX Tools Supervisor Pro > FX Workbench 6.x >
FX Workbench 6.x Pro or FX Workbench 14.x > FX Workbench 14.x Pro.

Relicensing the FX Supervisory Controller
If your FX Supervisory Controller is not currently part of a software maintenance agreement, you
must order a software upgrade license.

1. Email a request to software.manufacturing@jci.com for an upgraded license. Provide your host
ID (Qnx-####) and purchase order number (if buying a software upgrade license).

2. Receive the upgraded FX Supervisory Controller license and paste it into the licenses folder of
your FX Tools Supervisor Pro installation directory (C:\JCI\FXSupervisorPro-x.x\licenses).

3. Start FX Workbench by clicking Start > Programs > FX Workbench 6.x > FX Workbench 6.x Pro or
FX Workbench 14.x > FX Workbench 14.x Pro .

4. Connect to the FX Supervisory Controller by selecting File > Open Remote Station and entering
the IP address and platform and station login credentials.

5. Expose the Nav tree.

6. In the Nav tree, double-click Platform.

7. Double-click License Manager.

8. Click Import.

9. Click Import one or more licenses from files.

10. Click OK.

11. Select the location of the new FX Supervisory Controller license file you received in Step 2.
Note:  Select the license with Qnx- in the Host ID number.

12. Click OK.

13. Click Yes on the Licensing Complete dialog box to reboot the system.
Note:  The reboot process can take up to 5 minutes depending on network and computer
performance. There is no indicator for the progress of the reboot. If an attempt to
reconnect to the FX Supervisory Controller fails, wait for the system to complete the
reboot and try again.

14. Reconnect to the FX Supervisory Controller after the reboot process has completed.

Installing New Software into the FX Supervisory Controller
Important:  Be certain you want to upgrade an FX40 from version 1.2 to 2.0. Once you
upgrade the FX40 from version 1.2 to 2.0, you cannot downgrade back to 1.2.
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Note:  Go to Upgrading an FX20 to FX Supervisor Release 5.0 if you are upgrading an FX20 to
FX Supervisor Release 5.0.

1. Start the latest release of FX Workbench by clicking Start > Programs > FX Workbench 6.x > FX
Workbench 6.x Pro or FX Workbench 14.x > FX Workbench 14.x Pro.

2. Connect to the FX Supervisory Controller by selecting File > Open Remote Station and entering
IP address and platform and station login credentials.

3. Expand Platform.

4. Double-click Platform Administration and then click Commissioning.

5. Leave the default selections and click Next.

6. Verify that the license revision installed on the FX Supervisory Controller allows you to install
the latest software.

7. Click Install one or more licenses from files if the FX Supervisor requires an upgraded
license. Click Don't change any licenses if the installed license supports the FX Supervisory
Software revision being added.

8. Click Next.

9. Click UI+RUNTIME and click Next.

10. In the Station list, select Don't transfer a station and click Next.

Figure  1: Commissioning Wizard - Software Installation
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Figure  2: Commissioning Wizard - Software Installation

11. Click Upgrade All Out of Date. The system selects the check boxes next to the out-of-date
software. Use the scroll bar to locate and add additional .jar files that were added with the new
release but may not have been on the FX Supervisory Controller that is being upgraded.
In the Avail. Version column, look for .jar files from Johnson Controls. Select the check box to
include a .jar file in the upgrade process. For example, if you select the jciAutoImport .jar file,
then the file is included with the upgrade.
You do not need to add .jar files like jciLX, jciLXDevices, or jciLXMain unless you have a Lon-
Works® network.

12. Click Next. The Distribution File Installer lists the software that needs to be installed.

13. Click Next.

14. Leave the default selections and click Next.

15. Keep the current Platform name and password and click Next.

16. Click Finish. The station stops running. All .jar files are now updated.

Upgrading FX Server
1. If your FX Server is not currently part of a software maintenance agreement, you must order a

software upgrade license. Email a request to software.manufacturing@jci.com for an upgraded
FX Server license. Provide your host ID (Win-####) and purchase order number (if buying a
software upgrade license).

2. When you receive the upgraded FX Server license, paste it into the licenses folder of your FX
Server installation directory (C:\JCI\FXServer-x.x\licenses).

3. To obtain the most recent version of FX Server, order LP-FXWB-COPY or download it from the
Pro FX User Connected Community.

4. Install the new FX Server software.
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Note:  The license file you obtained in Step 1 should be automatically copied from your
previous installation directory and pasted into the licenses folder of your new installation
directory. If it is not, copy and paste it there.

5. Copy your station files from the old FX Server installation directory (C:\JCI\FXServer-x.x\stations
\station name) to the new FX Server installation directory.

6. Run the software by clicking Start > Programs > FX Server.

Troubleshooting
This section describes the most common problem encountered when upgrading an FX40 from
Release 1.x to 2.0, and how to resolve the problem.

Troubleshooting the File Too Large Error Message
A minimum of 3,072 KB (3.0 MB) of free file space is required to upgrade the FX40 to 2.0. A File
Too Large error message appears if the minimum file space is not available. Delete unused files to
increase the file space. Follow this procedure to delete the Graphic Templates on the FX40, which
are likely to be unused.

Note:  If you delete all the unused files and the minimum required free space is still not
available, the FX40 cannot be upgraded.

Table 6: Troubleshooting the File Too Large Error Message

Problem Solution
A File Too Large error message appears and the
upgrade cannot be completed

1. Close the File Too Large error message
and exit the installation wizard.

2. In the Navigation tree, expand the
Administration folder.

3. Double-click the Files folder. The
sysPxFile folder appears in the right
window (along with other folders and
files).

4. Double-click the sysPxFile folder. The
Graphic Templates files appear in the
right window.

5. Select all the files: click the top file, scroll
to the bottom of the window, hold down
the Shift key, and click the bottom file.
(Or press the Ctrl key and click individual
files to select only those files.)

6. Right-click the selected files and click
Delete. The selected files are deleted
from the FX40.
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Detailed Procedures for Migrating to FX Supervisory
Software 14.x
Migration is similar to upgrading, but signifies a larger change in software. Migration typically
requires more steps and conversions to move forward.
In the Appendix of this document, a high-level migration checklist has been provided to assist with
your decision on migration. See the Migration Checklist.

Prerequisites for Migration
If you are not at FX Supervisory Software 6.x, you must upgrade to FX Supervisory Software 6.x
before you migrate to FX Supervisory Software 14.x.
Before migrating an FX Supervisory controller, you need to have the following:

• a station running FX Supervisory Software 6.x. To upgrade FX Supervisory Software 6.x, see
Detailed Procedures for Upgrading FX Workbench 6.x and Earlier.

• a licensed version of FX Supervisory Software 14.x on your computer

• new FX Supervisory Software 14.x licenses for the controller that you are migrating

FX Supervisory Software 14 Migration Considerations
Many factors should weigh into the decision on whether or not to migrate an FX Supervisory
Controller and FX Server. This section provides guidelines for migration of your application.

Considering Platform Compatibility
Determine if the desired platform is compatible with FX Release 14.x. Use the following table as a
reference.
The information in the following table does not guarantee that you can migrate the station on that
platform; instead, the table explains which platforms are not able to migrate.

Table 7: Platform Compatibility

Platform Compatible with FX Release 14 Not Compatible with FX
Release 14

FX Supervisory
Controllers

• FX30E1,2

• FX602

• FX60E2

• FX702

• FX803

FX20

FX40
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Table 7: Platform Compatibility

Platform Compatible with FX Release 14 Not Compatible with FX
Release 14

FX Server Windows 7

Windows 8.1

Windows 10.0

Windows Server 2012

Windows® Vista®

Windows XP

Windows Server 2008

Linux®

1 Only compatible with FX Release 14 if the heap has been expanded.
2 The FX30E, FX60, FX60E, and FX70 Supervisory Controllers are only compatible with FX Release 14.0 through to 14.4.
3 FX80 Supervisory Controllers are compatible with FX Release 14.1 and greater (they are not compatible with 14.0).

Options for dealing with incompatible platforms include:

• Keep incompatible platform at or below FX Workbench Release 6.x. These platforms can interact
with platforms at FX Release 14.x with some limitations. The FX Server must be at FX 14.x, if any
other supervisory controller on the network is at FX 14.x. For example, to install or upgrade any
supervisory controller to FX 14.x, you must update the FX Server to 14.x. The FX Server must be at
the highest release, or greater, of any FX80 on the network.

• Replace the platform with a compatible platform.

Table 8: FX Supervisory Controller Network Compatibility

From To Supported Notes
FX Supervisory
Controller 14
(Station)

FX Supervisory Controller
4.x to 6.x (Station)

Yes Limited

FX Supervisory
Controller 4.x to 6.x
(Station)

FX Supervisory Controller
14 (Station)

Yes With exceptions

FX Supervisory
Controller 14
(Station)

FX Server 4.x to 6.x No Not blocked

FX Workbench 14 FX Supervisory Controller
4.x to 6.x (Platform)

Yes Connection is available for
migration process to FX
Supervisory Software Release
14

FX Workbench 14 FX Supervisory Controller
4.x to 6.x (Station)

No Blocked

FX Workbench 4.x to
6.x

FX Supervisory Controller
14 (Station)

No Blocked

FX Workbench 4.x to
6.x

FX Supervisory Controller
14 (Platform)

No Blocked

For more detailed information on compatibility, in FX Workbench 14 Pro from the Help menu, select
Help Contents. Click the Search tab and type compatibility.
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Considering Driver, Feature, and Application Compatibility
You must also consider driver, feature, and application compatibility. Facility Explorer Release 14
is a significant code base change. For modules that worked at Facility Explorer Release 6.x and
earlier to work at Facility Explorer 14 and later, they must be refactored. All modules developed by
Johnson Controls have been refactored for use in Facility Explorer Release 14 with the exception of
the Wireless TEC module.
Table 9: Johnson Controls Modules

Johnson Controls Module Refactored FX Release 14
jciAutoImport.jar Yes
jciBacnetParser.jar Yes
jciBACnetTEC.jar Yes
jciCoreParser.jar Yes
jciDictionary.jar Yes
jciFxDriver.jar Yes
jciFxDriverAppliance.jar Yes
jciFxDriverHx.jar Yes
jciMeters.jar Yes
jcin2.jar Yes
jciN2Parser.jar Yes
jciN2TEC.jar Yes
jciSpaces.jar Yes
jciSupport.jar Yes
jciTools.jar Yes
kitPxHvacSmall.jar Yes
wirelessStat.jar No

Note: The Wireless TEC module is loaded by factory default on all of the FX Supervisory
Controllers. The FX14UpgradeAssessmentTool does alert you that this module has not been
refactored for use for Facility Explorer Release 14. If the Wireless TEC is not being used, you
may choose to ignore this alert. We recommend, however, that you remove this module if it is
not in use. If the TEC module is being used, then the FX Supervisory Controller should not be
migrated to Facility Explorer Release 14.

For Niagara driver and application support, refer to the Niagara 4 Driver and Application Support
Section within the Niagara Help system to determine which drivers have been refactored for
Niagara 4 and FX Supervisory Software Release 14.
If the platform, drivers, features, and applications have been determined to be compatible and/or
supported for use with FX Supervisory Software Release 14, do the following:

1. If the platform is at a release less than FX Supervisory Software Release 6.x, you must purchase
and upgrade that platform to FX Supervisory Software Release 6.x and ensure it is running
properly before moving further. Use parts LP-FX40UPG-0 and LP-FXSWUPG-0 as appropriate for
the platform.

2. On supported FX Supervisory Controller platforms, run the FX 14 Upgrade Assessment Tool
to determine if the required resources are available. See FX Supervisory Software 14 Resource
Requirements.
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3. If the resource requirements are met, purchase the software maintenance parts for the
appropriate platform. Software maintenance may be purchased in 1, 3, or 5-year increments.
For more information on software maintenance parts, refer to the FX Supervisory Controller
Product Bulletin (LIT-12011406) and the FX Server (Release 14) Product Bulletin (LIT-12012250).

4. Follow the instructions on migrating your platform and station.

Considering License Compatibility
Licensing has been changed for FX Supervisory Software 14 and later. Licensing is moving from a
driver and integration model (FX Supervisory Software 6.x and earlier) to a field controller capacity
model (FX Supervisory Software 14.x and later).
FX Workbench, FX Servers, and FX Supervisory Controllers require the appropriate license to match
the Facility Explorer Release that it is running. For example, an FX Supervisory Controller running at
Release 6.1 requires the Niagara AX license.

Figure  3: FacExp.license in FX Workbench 6.1

In Figure 3, notice the FacExp.license (Niagara AX) in FX Workbench 6.1. The version is 3.8 and that
the jciN2 license is part of the FacExp.license file.
An FX Supervisory Controller running at Release 14.x requires not only a Niagara 4 license, but also
a Johnson Controls license (this is for the N2 protocol which was separated from the overall Niagara
AX license).

Figure  4: License in FX Workbench 14.x

In Figure 4, notice the FacExp.license (Niagara 4) in FX Workbench 14.x. Its version is 4.0 and no
jciN2 license is included.
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Figure  5: Johnson.license

Figure 5 displays the Johnson.license (Niagara 4) in FX Workbench 14.x. This license is required
when using the N2 protocol.
In general, a licensing model stays with a product throughout its lifetime. Parts purchased with an
LP- prefix follows the FX Supervisory Software 6.x and earlier license models. Parts purchased with
an FX- prefix follows the FX Supervisory Software 14.x and later 4.x license models.
The only exception to this rule is that to migrate a platform from FX Supervisory Software 6.x to FX
Supervisory Software 14.x, you must purchase and apply an FX- software maintenance part to an
LP- platform.

Note: Products with LP- prefix do not ship with Facility Explorer Release 14.x and later. These
products must be migrated in the field to use FX Supervisory Software 14.

Example of an FX Supervisory Controller Migration
Using the following flowchart as an example of when to migrate to FX Workbench 14.x.

Figure  6: Migrating an FX60 Supervisory Controller
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FX Supervisory Software 14 Resource Requirements
Facility Explorer 14 requires more disk space, Java® heap, and RAM to run than a similar Facility
Explorer 6.x station. Therefore, a controller with Facility Explorer 6.x running near capacity may not
fit the same-sized station when migrated to FX Supervisory Software 14. The reasons are as follows:

• Disk space (flash)–FX Supervisory Software 14 requires between 14 to 16 MB more space than
an equivalent FX Supervisory Software 6.x installation. Additional space is required by the new
Java 8 Virtual Machine (VM) and new HTML5 UX features that enable a rich browser experience.

• Heap space–For an equivalent station, more Java heap is required due to new features and
functionality. The baseline heap increase is about 10 MB. Additionally, more system memory is
required.

• History RAM disk size (FX60 and FX60E only)–The maximum history RAM disk size on an FX60
has been reduced from 64 MB to 32 MB to free additional system memory. The default RAM disk
size is 32 MB, so this should not affect most units. If the RAM disk on an FX60 with FX Supervisory
Software 6.x has been upgraded, then this increase in the RAM disk size comes at the expense of
heap space (for example, if you upgrade your memory, the additional 32 MB is allotted for heap
space and is not usable as RAM post-migration).

Note: Maximum history count has not changed.
Run the FX14UpgradeAssessmentTool on the Release 6.x Supervisory Controller to determine if it
meets the minimum requirements to be migrated to FX 14. The FX14UpgradeAssessmentTool is a
program that is included with the FX Workbench 14 installation. The program checks your controller
for memory and heap resources, disk space, .jar files, and for password encryption.

Note: For the migration, the Facility Explorer Upgrade Assessment Tool automatically
modifies the Backup Service to include the history and alarm data in the backup process
(which comes later in the process). However, because of possible size limitations, the four
graphics folders (sysGraphics file, sysGraphicsFileHx, sysPxFile, and sysPxFileHx) are removed
from the backup process. Although space is gained by the removal of these graphic files,
you no longer have access to these files after the migration. These files may be added post-
migration as space allows.

Important: After the FX14UpgradeAssessmentTool has completed, you must delete it from
the station; otherwise, it may cause the migration tool to fail.

Note: Before you perform this procedure, you must first install FX Workbench 14.

Default Values for the Backup Service Exclude Files and Directories
The following default values for the Backup exclude files and directories of the Backup Service. If
needed, you can change these settings after a station migration, so that the backup of the station
has the original settings.
Table 10: Default Values for the Backup Service Exclude Files and Directories

Field Description
Exclude Files *.hdb;*.adb;*.lock;*backup*;console.*;config.bog.b*;confi

g_backup*
Exclude Directories file:^^history

file:^^alarm
Offline Exclude Files *.lock;*backup*;console.*;config.bog.b*;config_backup*

Checking for FX Supervisory Software 14 Resource Requirements
To check for FX Supervisory Software 14 Resource Requirements:

FX Supervisory Controller Upgrade and Migration Instructions Technical Bulletin34



1. Start FX Workbench 6.x by clicking Start > Programs > FX Workbench 6.x > FX Workbench Pro
6.x.

2. In the Nav tree, expand:
My Host > My File System > C > JCI > FXWorkbench-14.x > jciStandards > to view the
FX14UpgradeAssessmentToolV1_9.bog

Figure  7: Copy Bog File

3. Right-click the FX14UpgradeAssessmentTool program object, and select Copy.

4. In the Nav tree, connect to and expand the station you want to migrate.
Important: You must run the assessment tool on the FX Supervisory controller station.
The tool cannot check the appropriate resources when the station is moved to run from a
computer.

5. Under Config > Services, right-click ProgramService and select Paste.

6. If you want to change the FX14UpgradeAssessmentTool program object name,
enter the new name and click OK. Otherwise, leave the name as is and click OK. The
FX14UpgradeAssessmentTool now appears under ProgramService.
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Figure  8: Change Tool Name

Figure  9: Paste File

7. Expand ProgramService and right-click FX14UpgradeAssessmentTool and select Actions >
Check Upgrade Status.
The tool generates a dialog box that displays requirement information and indicates if the
device meets the minimum requirements for migration to FX Workbench 14.
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Figure  10: Facility Explorer Upgrade Assessment

The FX14UpgradeAssessmentTool also indicates if it finds third-party modules (modules that
are not Tridium modules). All Johnson Controls modules work with FX Workbench 14.x with the
exception of the wirelessStat.jar.

Important: The NEEDS Update! WirelessStat message always appears. The
WirelessStat.jar file is included with every FX Workbench installation, but does not
work with FX Workbench 14.x. If you are using the wirelessStat driver for wireless TEC
controllers, you are not able to migrate to FX Workbench 14.x.

Important: The Client Password Test is a test to see whether user passwords can be
decrypted by the tool. If the test fails, you must go back to the FX Workbench 6.x version
of the station and re-enter the credentials, backup, and start again.
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8. Click OK.

9. To view additional information, double-click the FX 14 Assessment Tool.

Figure  11: Upgrade Compatibility Tool Property Sheet

10. In the Nav tree, right-click FX14UpgradeAssessmentTool and click Delete.
Note: To view a .txt file of the upgrade status, double-click Files from the Nav Tree for
the station. Double-click CompatibilityToolLog.txt. A .txt file appears displaying a text
version of the status generated by the compatibility tool.

Important: After using the FX14UpgradeAssessmentTool, you must delete it from the
station; otherwise, the tool may cause the migration tool to fail.

Checking for Multiple Admin Roles
To migrate a station, you must not have more than one user with the name Admin. If you have
more than one user with the name Admin, you must delete the extra users. If more than one user
exists with the same Admin name, the migration fails.

1. In the Nav tree, expand Station > Config > Services.

2. Double-click User Service. The User Manager appears.

3. In the view selection on the top-right side of the screen, select  AX Slot Sheet.

4. Review the names in the Name column. In the example above, notice that slot number 9
contains admin and slot number 14 contains ADMIN. Only one admin name is allowed (even if
capitalization is different). The user roles have the baja:User type.
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5. If you have more than one user with the name Admin, right-click the duplicate name (with the
baja:User type), and select Delete.

Backing Up Your FX Workbench 6.x Station
For the migration to FX Supervisory Software 14, back up the station using FX Workbench 6.x. You
cannot backup a 6.x FX Supervisory Controller from FX Workbench 14.

Note:  Make sure to move the station from the FX Supervisory Controller to the Local Host via
the Station Copier after you back up the station. Doing this guarantees that there is space on
the FX Supervisory Controller when you install FX Workbench 14.

1. In FX Workbench 6.x, connect to the station you want to back up.

2. Right-click the station you want and select Backup Station. A screen appears prompting you to
save the backup .dist file to a location.

Figure  12: Station Backup

3. If necessary, enter a different name of the backup in the File name field.

4. Click Save. You can view the backup in the BackService, which is located in Station >
Administration > BackupService.

Note: You can also back up your station by going to Station > Services> BackupService,
selecting the desired .dist file, and clicking  Backup.

Running Platform Daemon 14.x
When opening the Platform Daemon 14.x, you are indicating the version of FX Workbench you want
to run.
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Note:

• Certain antivirus programs may attempt to block you from running the Platform Daemon
software.

• Before running the platform daemon, be sure to close out any instances of FX Workbench
software.

Click Start > FX Workbench 14.x > Install Platform Daemon 14.x. You can now start FX Workbench
14.

Migrating the 6.x Station to Facility Explorer 14.x
During the station migration, we recommend that you have a serial shell open to help you monitor
the migration. Having the serial shell open helps you monitor the items being loaded on the FX
Supervisory Controller, track errors, and view when the migration is finished. For more information
about the serial shell, see the About JACE Serial Shell Mode section of the Niagara Help.

• By default, files in the SysPxFile, SysPxFileHx, SysGraphicsFile, or the SysGraphicsFile folders are
not migrated to the converted station.

• If you are migrating a station that uses older graphics with a tab pane, you need to clean the
graphics up to remove the tabs.

1. Start FX Workbench 14.

2. On the Tools menu, click Migrate Station.

3. In the Backup DIST Name (Ver 3.8) field, click the folder button and select the .dist file
from the FX Workbench 6.x backup directory. For example, c:\JCI/FXWorkbench-6.2/backups/
backup_SunriseClinic_151121_0914.dist. After selecting the .dist file, click Open.

4. Do one of the following:

- If you are migrating an FX Supervisory Controller station, click Migrate JACE Station.

- If you are migrating in FX Server, click Migrate FX Server Station.

5. Click Migrate Station. The migration tool begins the migration process. The migration
background screen appears. Use this screen to monitor the progress of the migration. This
process can take several minutes.
As the migration is running, the system creates a log file whose name is a the combination
of backup .dist file name (backup_SunriseClinicA_Migrate.dist) plus _miglog_ plus the
date/time code 151007_1539 plus .html.
For example: backup_SunriseClinicA_Migrate.dist_miglog_151007_1539.html.
Locate the log file in the Nav tree under My File System > User Home > stations.

Note: Before the migration process finishes, a lock file is created that uses the log file
name plus .lck file name extension. Once the migration finishes, this .lck file is delete.

6. The Migration screen displays that the migration is completed. When prompted by the
migration background screen, press any key to continue. Windows Explorer appears and is
opened to the directory where the migration .log file was placed.

7. Click Close. The station has now been migrated and is ready to be loaded on the FX
Supervisory Controller.
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Installing the Distribution File
1. On the File menu, select Open > Open Platform. The Connect screen appears.

Figure  13: Connect

2. In the Type field, select the session type.
Important: The Type field defaults to Platform TLS Connection, which may not be
enabled on the controller. Select Platform Connection if TLS is not enabled.

3. Enter the IP address of the device to migrate and click OK.

4. Log into the Platform for the device you want to migrate. These credentials are the same
credentials used to log into the platform of the FX Supervisory Controller at Release 6.1.

5. In the Nav tree, double-click Platform > Platform Administrator. The Platform Administrator
screen appears. Confirm that the Baja Version Niagara 3.8.x.

Note:

- If the Baja version is less than 3.8.x, then you must first upgrade to FX Workbench
6.x. See Detailed Procedures for Upgrading FX Workbench 6.x and Earlier.

- A warning message may appear on the screen indicating the default platform
credentials. The migration process requires you to change the default platform
credentials to a different user name and strong password.

6. In the Nav Tree, expand Platform and double-click Distribution File Installer. The Distribution
File Installer screen appears.

7. On the bottom of the screen, click Conversion. Conversion files that are not appropriate for
use on the current FX Supervisory Controller are disabled.

8. Select the bold (non-disabled) .dist file and click Install. A message appears indicating that
running applications need to be stopped before the installation can proceed.
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Figure  14: Stopping Applications

9. Click Finish. FX Workbench 14 installs the base Niagara 4 image on the controller. The status of
the installation appears on the Installing Distribution screen. The installation may take several
minutes.

10. When the installation is complete, click Close. The controller reboots. The reboot may take
several minutes.

11. Log back into the platform and open the Platform Administrator. Confirm that the device
Daemon Version now says 4.0.xx.xx and the Baja version is blank. The installation of the
conversion distribution file may revert the platform credentials back to the default values.

Commissioning the Station
After migrating the station to FX Supervisory Software 14, you need to commission the station.

1. In the Nav tree, expand Platform.

2. Double-click Platform Administrator.

3. Click Commissioning.
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Figure  15: Commissioning Wizard

4. Select the check boxes based on the following table. Make sure the Configure additional
platform daemon users is checked.

Table 11: Commissioning

Field Description
Request or install software licenses Preselected and disabled for any new FX

Supervisory controller
Set enabled runtime profiles Preselected and disabled for any new FX

Supervisory controller
Install a station from the local computer Ensure that this field is selected as you will be

installing the new migrated station from a local
computer.

Install lexicons to support additional languages Option to install file-based lexicon sets
(alternative to lexicon modules). Typically you
leave this field unselected. Lexicon modules are
recommended in FX 14.

Install/upgrade modules Always preselected when the wizard is run.
Selects the software modules and optionally any
lexicon modules.
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Table 11: Commissioning

Field Description
Install/upgrade core software from distribution
files

Preselected and enabled for any new FX
Supervisory controller

Sync with my local system date and time Preselected in most cases. For new controllers
(for example) where the controller time may
greatly differ from actual time.

Note: Ensure that this field is selected to
update the date and time from the defaults
placed in the controller with the conversion
AXtoN4 distribution file.

Configure TCP/IP network settings Recommended
Configure system passphrase Preselected and enabled for any new FX

Supervisory controller
Remove platform default user account Preselected and enabled for any new FX

Supervisory controller. You cannot commission
a unit with the factory-default platform admin
user.

Configure additional platform daemon users Recommended option if you require additional
platform admin user accounts with unique user
names and passwords (all additional accounts
have full and equal privileges).

5. Click Next. The Station Installation screen appears.

Installing or Updating Licenses
1. Select Install one or more licenses from files if you have the FX Workbench 14 license file.

2. Click Add and select the required licenses. The licenses appear on the right side of the screen.

3. Click OK.

4. Click Next.

Setting the Enabled Runtime Profiles
Enabled runtime profiles specify what types of FX Supervisory Software 14 software module .jar files
to install.
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Figure  16: Enabled Runtime Profiles

1. Use the following table as a reference. Make sure to select both the UX and WB check boxes.
Table 12: Enable Runtime Profiles

Field Description
RUNTIME: Module JARS having core runtime
Java classes only, no user interface.

Read-only. Always selected.

UX: Modules JARs having lightweight
HTML5+Javascript+CSS user interface only.

Select to support web client browser access,
using HTML5, Javascript®, and CSS technologies.
The client does not need to run Java and
download WbApplet from the controller.
When you select this field, the WB field is also
selected.

Note: Certain views at FX Release 14 have
not been converted to HTML5. These views
include the Device Manager, Wire Sheet,
and Px Editor views. They are scheduled to
be converted at a future release.

WB: Modules JARs having Workbench or
Workbench Applet user interface classes.

Auto-selected when you select UX. Select WB
if the supervisory controller must also support
browser Web Workbench access from Java-
enabled clients, using the WbApplet.

SE: Modules JARs having Java classes that use
the full Java 8 Standard Edition (SE) platform API.

Not available for QNX-based FX Supervisory
Controllers.

DOC: Modules JARs having no module classes. Selectable, but not recommended for file space
reasons on an FX Supervisory Controller.
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2. Click Next. The Station Installation screen appears.

Specifying a Station to Install
To commission the station, you must first specify the station to install.

Figure  17: Station Installation

1. In the Station box, select the name of the station database on your computer.

2. If desired, enter a new station name. Otherwise, do not change it.

3. Enter the system passphrase.

4. If desired, select one or both of the following check boxes (we recommend that you select both
check boxes):

- START AFTER INSTALL: Start the station immediately after it is copied.
- When you select this check box, the station is restarted at the end of

commissioning, even if you do not reboot the FX Supervisory Controller.

- AUTO-START: Start the station every time the platform daemon starts.
- When you select this check box, the station starts every time the FX Supervisory

Controller is rebooted.

5. Click Next. A dialog box appears asking which station files to copy.

6. Select one of the following:

- Copy files from selected directories (recommended)
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- Allows you to specify which subfolders under that local station that are copied. This
action produces a tree selection after you click Next.

- Copy only the config.bog station database file
- Copies only the station configuration (components), and not any supporting

folders and files (for example, PX files and HTML files).

7. Click Next. A screen appears asking you to select subfolders.

8. Select the subfolder under the local station to copy. Expand the folders as needed. By default,
the directories are selected to be copied to the station. Directories that are not selected are no
longer required. Typically, you leave all directories selected.

9. Click Next. A dialog box appears asking you to select the software to install.

10. Select the software to install.

11. Click Next.

Installing Core Distribution Files
During commissioning, the dependencies of the FX Supervisory Controller platform are compared
against the distribution (.dist) files available in your FX Workbench computer's software database.
The wizard determines what .dist files need to be selected for installation. The software you need to
install is displayed on the screen.
Click Next to select the distribution files. A TCP/IP configuration screen appears.

Configuring TCP/IP Settings
To commission the station, you may need to update the station's TCP/IP settings.

1. Review the settings on the IPv4 Settings tab, which include the temporary factory-shipped IP
address.

2. Assign the controller a unique IPv4 address for the network you are installing it on. No other
device on this network should use this same IP address. Include the appropriate subnet mask
used by the network.
Alternatively, if the network supports DHCP, you can enable it by selecting the DHCPv4
Enabled check box. In this case, the IP Address and Subnet Mask fields become read-only.

Note: In general (for stability), we recommend static IP addressing over DHCP. Do not
enable DHCP unless you are certain that the network has DHCP servers. 
Otherwise, the FX Supervisory Controller may become unreachable over the network.

3. If needed, adjust other TCP/IP settings, which include:

- Hostname–Use the default localhost name or enter another name you want to use for
this host.

- Hosts File–Click the arrows to expand the edit field. The format is a standard TCP/IP
hosts file, where each line associates a particular IP address with a known host name.
Use a separate line for each entry. Place the IP address in the first column, followed by
the corresponding host name. The IP address and the host name are separated by at
least one space.

- DNS Domain Name–Enter the name of network domain, or if not applicable, leave the
field blank.
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- IPv4 Gateway–Enter the IP address for the device (such as a switch or a router) that
forwards packets to other networks or subnets.

- DNSv4 Servers–Click the plus sign for a field to enter the IPv4 address of one or more
DNS servers.

4. Click Next.

Updating the System Passphrase
All Niagara 4 platforms have a system passphrase (password), which encrypts sensitive information.
This information includes client passwords stored in .bog files and station databases (config.bog
files) or station backup distribution (.dist) files. The passphrase increases security for the files that
contain critical information. In various FX Workbench 14 operations, you are prompted to enter the
passphrase, such as when copying stations or restoring station backups in remote platforms. The
following areas in the framework are affected by passphrase implementation:

• Provisioning

• File Transfer Client

• Station Copier

• Backup

• Commissioning

• Export Tags

The sensitive information in files is protected with encryption, either by encrypting the information
within the files or by encrypting the whole file. How the encryption is applied depends on the
portability of the file. Files located under the daemon User Home (files that belong to the system)
are encrypted using a strong, randomly generated key that exists only on that system. Files located
under an FX Workbench 14 User Home (portable files that can be sent to many systems) are
encrypted using a key derived from the user-defined system passphrase entered during software
installation or when the system passphrase changes.
Due to the different types of encryption used for the system or portable location, when
transferring files between the daemon User Home and another FX Workbench User Home, you
must use the FX Workbench platform tools (Station Copier, File Transfer, or Backup). Using the
platform tools converts files to use the correct encryption key for the target location.

Important: Do not use Windows Explorer to copy files between the daemon User Home and
other User Homes because without the proper encryption, the files may not be readable.

For System-to-Portable Transfers
You can get portable copies of files located under the daemon User Home by any of these methods:

• Make a backup from the Platform Administration view

• Make a backup from a running station

• Use either Station Copier or File Transfer Client from the Platform Administrator view

The resulting local, portable copies and backup files are protected with a passphrase.
For Portable-to-System Transfers
When you use the Distribution File Installer to restore a backup .dist file, or if you use the Station
Copier to transfer a station from your FX Workbench directory to a controller, the file's passphrase
is validated and used to translate the data back into the proper system encryption format for use
under the daemon User Home.
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Important: Remember the system passphrase and keep it safe. If you lose the system
passphrase, you lose access to encrypted data and you will need to revert to the default
system setup using the Serial Shell.

1. In the Current Passphrase field, enter the default platform password. Contact your local
Johnson Controls representative for the default password.

Note: If the default platform password has changed in the field, use the changed
password. If you have forgotten the default platform password, you can use the Serial
Shell method to reset to the default password.

2. In the New Passphrase field, enter a new passphrase. The passphrase must be at least
10 characters long with one uppercase character, one lowercase character, and one digit
(numeral).

3. In the Confirm New Passphrase field, enter the new passphrase again.

4. Click Next.

Specifying a Platform User to Replace the Factory-default Platform User
To commission a station, you need to create a new platform account.

1. In the User Name field, enter a user name for platform login.
Note: You are not allowed to use jci as a user name.

2. In the Password fields, type in a strong password (it must match in both password fields). The
password must use a minimum of eight characters, using at least one digit (numeral).

3. If you want, enter an alphanumeric descriptor for this platform admin user in the Comment
field. The comment is seen in the Users table if there are more than one platform user.

4. Click Next.
Note: The new platform user account is retained in the controller. For example, if you
migrate to FX Workbench 14 and then take the station back to FX Workbench 6.x, then
forward again to FX Workbench 14, you need to use the new platform credential defined
in this procedure.

5. Do the following:

- To add new users, click New User and enter the user information.

- To delete users, select the user and click Delete User.

- To change a password, click the user and click Change Password. Enter the new
password.

Reviewing the Changes
Before you finish commissioning, review the changes and make sure the commissioning selections
have been reflected. Click Back to correct any configuration errors when commissioning the
controller.

1. Click Finish. The Completing Commissioning screen appears. This process takes several
minutes.

2. After commissioning is complete, click Close. The Facility Explorer 14 station is now copied to
the controller. The controller is rebooted and may take several minutes to complete.

49FX Supervisory Controller Upgrade and Migration Instructions Technical Bulletin



Changing the Default Web Profile to Use the HTML5HxProfile
Beginning at FX Workbench 14, you can take advantage of a rich web experience without the need
to install and manage a Java based plug-in. Use the following procedure to change the default web
profile to the HTML5HxProfile.

Note:

• The migrated station cannot render the Extensions tab of a graphic in HTML5 view.

• Certain views at FX Release 14 have not been converted to HTML5. These views include the
Device Manager, Wire Sheet, and Px Editor views. They are scheduled to be converted at a
future release.

• To add a new user which uses the HTML5HxProfile, you must first make a secure connection
to the station.

1. In the station, go to Config > Services > User Services.

2. Double-click the user. The user property sheet appears.

3. In the Default Web Profile section, select HMTL5HxProfile in the Type field.

4. In the Default Web Profile section, select the default FX Workbench display options based on
the following table.

Table 13: Default Web Profile

Field Description
HX Theme Select Zebra for a black and white color theme.

Select Lucid for a blue and gray color theme.
Enable HX Workbench Views Select Yes to enable the HX Workbench View.

Select No to disable the HX Workbench View.
Enable Nav Tree Side Bar Select Yes to enable the Nav Tree Side Bar.

Select No to disable the Nav Tree Side Bar.
Enable Palette Side Bar Select Yes to enable the Palette Side Bar. Select

No to disable the Palette Side Bar.
Enable Nav File Tree Select Yes to enable the Nav Tree. Select No to

disable the Nav Tree.
Enable Config Tree Select Yes to enable the Config Tree. Select No

to disable the Config Tree.
Enable Files Tree Select Yes to enable the Files Tree. Select No to

disable the Files Tree.
Enables Histories Tree Select Yes to enable the Histories Tree. Select

No to disable the Histories Tree.
Enable Hierarchies Tree Select Yes to enable the Hierarchies Tree. Select

No to disable the Hierarchies Tree.

5. In the Type Spec field, select hx and then HTML5HxProfile.

6. Click OK.
Note: To update an existing Nav file when you upgrade to FX 14.4, click Tools and select
Update Home Page Graphic.
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Viewing and Updating Metaspace
Use the following procedures if you receive an error in the Application Director indicating that you
are out of metaspace.

Viewing Metaspace
1. In the Nav Tree, right-click on the station and select Spy. A Remote Station menu appears on

the screen.

2. Click util. A util menu appears on the screen.

3. Click JMX Info. A JMX Info screen appears.

Updating Metaspace
Use the following procedures if you receive an error in the Application Director indicating that you
are out of metaspace. The station is automatically restarted after the metaspace memory allocation
has been updated.

1. In your station, log into the Platform.

2. In the Nav tree, double-click Platform Administration. The Platform Administration screen
appears.

Figure  18: Platform Administration

3. Click Configure NRE Memory. The Configure NRE Memory Pools screen appears.
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Figure  19: Metaspace Size - 30 MB

4. Note the metaspace size.

5. Drag the left slider so that the metaspace size is between 36 MB and 46 MB.

6. Click Save.

7. Click Yes to restart the station.

Upgrading FX Server to FX Supervisory Software 14
FX Server uses a similar upgrade process as supervisory controllers. However, there is no need to
use the FX14UpgradeAssessmentToolV1_9 with the FX Server to determine whether there are
enough resources to migrate.
Use the following process when you upgrade an FX Supervisory Software 14.

1. Back up the FX Server to create a .dist file. For details, see Backing Up Your FX Workbench
6.x Station. Also go to the Backup Service to ensure that the history and alarm entries are
removed (so the system does not bring the histories and alarms in the backup file).

2. Run the migration tool. For details, see Detailed Procedures for Migrating to FX Supervisory
Software 14.x. In the migration tool, be sure to:

- select the .dist file that you backed up.

- select Migrate FX Server Station.
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Reverting a Station from FX Supervisory Software 14.x to FX
Supervisory Software 6.x

Note: We recommend that you run a serial shell running to monitor the progress of this
installation. Having the serial shell open helps you monitor the items being loaded on the FX
Supervisory Controller, track errors, and view when the migration is finished.

1. In FX Workbench 14, connect to an FX Supervisory Controller platform.

2. Go to the Station Copier and delete the FX Supervisory Controller 14 station.

3. On the Nav tree, select Platform > Distribution File Installer. The Distribution File Installer
screen appears.

4. On the bottom of the screen, click Conversion. Conversion files that are not appropriate for
use on the current FX Supervisory Controller are disabled.

5. Select the bold (non-disabled) .dist file and click Install

6. If a station is running, a dialog box appears indicating that FX Workbench must stop the
station prior to installing the .dist file.

7. Click Finish. The Installing Distribution screen appears and the installation begins. This process
may take several minutes.

8. Once the distribution file is installed, click Close.

9. Close FX Workbench 14.

Running Platform Daemon 6.x
When you open the Platform Daemon 6.x, you are indicating the version of FX Workbench you want
to run.

Note:

• Certain antivirus programs may attempt to block you from running the Platform Daemon
software.

• Before running the platform daemon, be sure to close out any instances of FX Workbench
software.

Click Start > FX Workbench 6.x > Install Platform Daemon.

Installing a Backup 6.x Station
1. Open the platform for the FX Supervisory Controller. Use the default platform ID and password

(jci/FacilityExplorer61 or explorer).

2. In the Nav tree, select Platform > Distribution File Installer. The Distribution File Installer
screen appears.

3. Click Backups and select the backup .dist file to install. The backup file must match the FX
Supervisory Controller platform for the backup to be enabled in the list of backup files.

4. Click Install.
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5. Click Next. If the backup has different TCP/IP settings than when the backup was created, a
screen appears prompting you to keep the existing TCP/IP settings or change them to what
was used when the backup was previously run.

Figure  20: Restore TCP/IP Settings

6. Edit the settings as needed and click Finish. FX Workbench begins installing the backup of the
6.x station.

7. Click Close.
Note: If you want to migrate back to FX Workbench 14.x, you need to obtain another
license for FX Workbench 14.x.

Note: If you want to migrate back to FX Workbench 14.x, the platform credentials from
your previous migration were retained. You need to use those credentials. If you have
forgotten the default platform password, you can use the Serial Shell method to reset to
the default password.

Cleaning Tabbed Graphics
Graphics with tabs at the bottom can still work in FX Supervisory Software 14.x. However, the way
these tabbed graphics were designed, the layout of the graphics within the tabs do not render
properly in FX Supervisory Software 14.x.
We recommend you remove the tabs to make them look more in line with FX Supervisory Software
14.x.

1. In FX Workbench, open the property sheet of the device you want to change the graphic for.
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2. In the PX File field, note the .px file. This is the file that you need to edit.

3. In the controller's directory structure, navigate to Files > px and double-click the file noted in
Step 2. Notice the tabs at the bottom of the image.

Figure  21: Tabbed Image

4. In the view selector at the top right of the screen, select PxEditor.

Figure  22: PxEditor - All Tabs

5. To remove tabs from graphics and change the graphic to use a scroll pane instead of a border
pane, in the Widget Tree pane, expand BorderPane (Root) > TabbedPane (Content). Right-click
and delete all the LabelPane entries.

6. In the view selection, select Text Editor.
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7. Go to the opening tags for the TabbedPane section of the Text Editor. Remove the following
lines:
<TabbedPane = "content" tabPlacement= "bottom">
<LabelPane>
<Label name = "label" text = "Graphic"/>

8. Go to the closing tags for the TabbedPane section of the Text Editor.

9. Remove the following lines:
</LabelPane>
</TabbedPane>

10. To reset the canvasPane to orient to the top left and remove scaling, go to the CanvasPane
Properties of the graphic.

11. Select the following values:

- In the halign field, select Left.

- In the scale field, select None.

- In the valign field, select Top.

12. Click OK.

Troubleshooting
Table 14: Migration Troubleshooting

Problem Description
The Migration Results section in
the Migration Report file indicates
that .dist file did not complete
successfully. The Failure List
includes the following error
IllegalNameException: There can be
only one Admin role.

Although multiple roles with the name admin roles can
be configured and exist on an FX Workbench 6.x station,
the migration enforces only role with the name Admin
role for Migration. Delete any additional roles with the
name admin leaving only a single one remaining. Once
the additional Admin roles have been removed, run the
migration tool again.

Note: The additional roles with an Admin name may
be hidden. To view and remove hidden roles, use the
Slot Sheet view of the UserService. Also, having the
names admin and Admin is considered having two
admin roles.

When running the Migration Tool, the
Client Password Test Fails.

The Client Password test ensures that passwords in the FX
Supervisory Software 6.x station can be decrypted for use
in FX Supervisory Software 14.x. A failure indicates that a
password could not be decrypted. If a failure occurs, re-
enter the password for the failed user in the running FX
Supervisory Software 6.x station and re-run the Migration
Tool.
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Table 14: Migration Troubleshooting

Problem Description
The FX14UpgradeAssessmentTool
does not indicate whether the free
disk space, free heap memory, or
RAM disk size have passed.

For FX Supervisory Controllers, the
FX14UpgradeAssessmentTool must be run on the
controller itself.

Note: Running the FX14UpgradeAssessmentTool on
a station running on a computer does not check for
free disk space, free heap memory, and RAM disk size.

When trying to access the web
user interface with Firefox™, there
is a pop-up dialog box that keeps
disappearing before I can interact
with it.

In the Add-ons section, set the Java Platform plug-in to
Always Activate. Close all instances of the browser, restart
the browser, and navigate to the web user interface. The
dialog box should now stay visible in order for you to
interact with it.

When trying to migrate my station,
you cannot log into the platform with
FX Supervisory Software 14.x

The host remembers credentials from a previous attempt
to migrate. For example, if you attempt to migrate a
station from FX Supervisory Software 6.x to FX Supervisory
Software 14.x and then decide to take it back to FX
Supervisory Software 6.x, the FX Supervisory Software 14.x
platform credentials are still retained in the host. When
you attempt to migrate to FX Supervisory Software 14.x the
second time, the required credentials are the ones defined
during the first attempt. If you have forgotten or do not
have those credentials, the defaults can be reset using a
Serial Shell connection to the host.

A station migrated to FX Supervisory
Software 14.x still needs a JAVA plug-
in for the browser.

Migrating a station does not automatically change user
profiles to the new HTML5HxProfile. You must change the
Default Web Profile to HTML5HxProfile for each user that
requires this functionality. For more details, see Changing
the Default Web Profile to Use the HTML5HxProfile.

When adding a new user or
modifying a password, the fields are
disabled in the user interface.

Starting with FX Supervisory Software 14.x, you are no
longer allowed to add or modify sensitive information
when using a non-secure connection. Refer to the FX
Workbench User Guide (LIT-12011149) for more information.

Browser displays Your connection is
not private.

This message appears because the security certificate
cannot be verified. Click the Advanced link, and then click
the Proceed to ###.###.###.### (unsafe) link.

An Install software error appears
when installing the distribution file.
Install Software: Failed

There may not be enough room on the controller. Go to
the Station Copier and, if there is an the FX Supervisory
Controller 14 station on the controller, delete the station
from the controller.
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Table 14: Migration Troubleshooting

Problem Description
The following error appears when
logging into a station using a web
browser. HTTP ERROR 500

Problem accessing /ord/station
%7Cskit:fxApp Reason:

java.baja.xml.SException: Unknow type
ForecaseView [line80]

The forecasting module used with FX Workbench Home
pages does not work with FX Supervisory Software Release
14. If you are trying to view a migrated station's Home
page using the HTML5HxProfile view, an error appears if
the Hx view in the forecasting information is not removed
from the view.
1. On the Home page, select Edit Site Home from the

view selector (top-right corner of the screen).

2. Click and drag to select all of the Weather Forecast
objects in the lower left are of the Hx graphic.

3. Press Delete.

4. Change the view back to the appropriate Home page.
When asking if you want to save your changes, click
Yes.

Problem
My graphic no longer appears in my migrated station.

Description
FX Supervisory Software 6.x may have been able to render some file types which have certain
characters in the filename that are not recognized (see the following sections for guidelines around
naming). Rename your file with appropriate characters and re-link your graphic as necessary.

Component Naming
In a FX Supervisory Software 6.x station, you should name components using the following set of
rules:

• Only alphanumeric (A-Z, a-z, 0-9) and underscore (_) characters are used.

• Symbols characters (for example, %, &, ., #) are not allowed.

• The first character in the name must be a letter (not a numeral).

• Name must be unique for every component within the same parent component.

• Naming is case-sensitive. For example, zone21 and Zone21 are unique names.

Note: Case differences among names affect the sorting of names in table-based views. The
sorting order uses capital letters (A-Z) first and lower case (a-z) following.

To convey multiple word names without using spaces, naming conventions such as Camel-
Case and underscores are often used, as needed. For example:

• Floor1 or Floor_1

• ReturnAirTemp or Return_Air_Temp

• Zone201_SAT or Zone_201_SAT
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Escaped Names
You can name components in FX Workbench  incorrectly, such as with spaces or other non-
alphanumeric characters. Further, various FX Supervisory Software 6.x drivers have learn features
to automate the creation of points, some of which (by default) may also have such incorrect names
—reflective of the native name of the source object. For example, a BACnet proxy point might have
the default name Zone 6 RH% that matches the actual (native) BACnet object’s name.
Be aware that the actual component name has all illegal characters escaped using a $ character,
along with the ASCII code for that character, in hexadecimal code. For example, a proxy point has
the name Zone$206RH$25, where the $20 replaces the space and the $25 replaces the %. You
can see these escaped names in the slot sheet of the component’s parent container. Or with the
component selected, look at its ord (shortcut Ctrl + L) to see the actual name.
For the most part, this escaped name scheme is transparent to users. When the name appears
to the user (for example, in the Nav tree, property sheet, wire sheet, or a point manager), the
component’s name is unescaped by replacing the code (for example, $20) with the actual ASCII
character (for example, a space). This way, the user sees Zone 6 R % and so on. This is the
component’s display name.
In some cases, escaped names lead to confusion. Avoid them or rename them, if possible. For
example, if you add history extensions to escaped-named points, you see those escape codes listed
for source points when accessing the History Ext Manager (although associated histories use the
display names). If you build Px pages and manually type the ords in Px widgets, you probably know
source points by display names only. If you manually type in an ord without the actual (escaped)
name, the widget binding fails with an error.
When using the HTML5HxProfile, the home page graphics created with previous versions of Facility
Explorer use a forecasting module. This module has not been updated for use with HTML5 and still
requires a Java plug-in. You can remove the components on the home page so that the rest of the
Home Page can appear without errors.

Related Documentation
Table 15: Related Documentation

For information about See document LIT or Part Number
The Features, Benefits, and
Specifications of the FX Supervisory
Controller

FX Supervisory Controller Product
Bulletin

LIT-12011406

FX30E/FX60E Supervisory Controller
Installation Instructions

Part No. 24-10174-115

FX70 Supervisory Controller
Installation Instructions

Part No. 24-10564-17

How to Install the FX Supervisory
Controller

FX80 Supervisory Controller
Installation Instructions

Part No. 24-10143-861

The Features, Benefits, and
Specifications of the FX Server

FX Server Product Bulletin (6.x and
Earlier)

FX Server Product Bulletin (14.x and
Later)

LIT-12011122

LIT-12012251

The Operation of FX Workbench FX Workbench User's Guide LIT-12011149
How to Install FX Workbench FX Supervisory Controller Family

Software Products Installation
Instructions

LIT-12011965
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Appendix
Migration Checklist

Action Resources

Check the platform compatibility
list to determine whether or not the
desired platform can be migrated.

Refer to the FX Supervisory Controller Upgrade and
Migration Instructions (LIT-12011441).

Check driver, feature, and
application compatibility.

Refer to the FX Supervisory Controller Upgrade and
Migration Instructions (LIT-12011441).

Refer to the Niagara Help > Features and
compatibility between N4 and AX.

Refer to Niagara Help > Wire compatibility between
Niagara 4 and Niagara AX.

Check directly with third-party vendors.
Purchase the appropriate FX
Supervisory Software 14 Software
Maintenance for FX Servers and FX
Supervisory Controllers (to move
from 6.x to 14.x).

Refer to the FX Supervisory Controller Product
Bulletin (LIT-12011406).

To place your order, contact Johnson Controls
Product Software Sales at 1-414-525-7906 or
1-800-275-5676, email jciorder@jci.com, or
fax to 1-800-356-1191. For answers to pricing
questions, contact your channel account
manager.

Migrate FX Server and FX
Supervisory Controller stations
and change users default profile to
HTML5HxProfile as desired.

Refer to the FX Supervisory Controller Upgrade and
Migration Instructions (LIT-12011441).

FX Workbench 14.x Modules
Use this table as a reference when selecting modules during FX Workbench commissioning. This
modules listed below are the suggested modules needed for the JCI appliance on an FX80. All
modules sizes are approximate.
Table 16: FX Workbench 14.x Modules

Module Name Size Notes Module Name Size Notes
alarm-rt.jar 339.5

KB
kitPx-ux.jar 11.7 KB

alarm-ux.jar 178.6
KB

kitPx-wb.jar 121.8
KB

alarm-wb.jar 488.6
KB

kitPxHvac-wb.jar 634.8
KB

app-rt.jar 21.1 KB kitPxHvacSmall.jar 443.3
KB
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Table 16: FX Workbench 14.x Modules

Module Name Size Notes Module Name Size Notes
app-wb.jar 13.2 KB mobileThemeZebra-

ux.jar
24 KB

axvelocity-rt.jar 1383.5
KB

mobile-ux.jar 519.9
KB

axvelocity-wb.jar 28.9 KB mobile-wb.jar 195.5
KB

backup-rt.jar 62.3 KB modbusAsync-rt.jar 24.2 KB

backup-wb.jar 23 KB modbusAsync-wb.jar 9.8 KB

bacnet-rt.jar 1825.7
KB

modbusCore-rt.jar 220.2
KB

bacnet-ux.jar 190.2
KB

modbusCore-wb.jar 46.7 KB

bacnet-wb.jar 311.5
KB

modbusTcp-rt.jar 31.2 KB

baja.jar 2200.6
KB

modbusTcp-wb.jar 11.3 KB

bajaScript-ux.jar 434.1
KB

neql-rt.jar 82.5 KB

bajaui-wb.jar 1280.7
KB

net-rt.jar 63.6 KB

bajaux-rt.jar 28.5 KB niagaraDriver-rt.jar 360 KB

bajaux-ux.jar 89.5 KB niagaraDriver-wb.jar 183.6
KB

basicDriver-rt.jar 59.3 KB niagaraVirtual-rt.jar 133.5
KB

box-rt.jar 203.8
KB

niagaraVirtual-wb.jar 17.9 KB

bql-rt.jar 269.3
KB

nsh-wb.jar 20.8 KB

bql-ux.jar 63 KB obix-rt.jar 218.1
KB

chart-rt.jar 14.9 KB obixDriver-rt.jar 324.4
KB

chart-wb.jar 200.3
KB

obixDriver-wb.jar 63 KB

control-rt.jar 79.7 KB pdf-wb.jar 112.9
KB

control-ux.jar 31.3 KB platBacnet-rt.jar 25.9 KB

control-wb.jar 22.5 KB platCrypto-rt.jar 119.4
KB

converters-rt.jar 129 KB platCrypto-wb.jar 206.6
KB
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Table 16: FX Workbench 14.x Modules

Module Name Size Notes Module Name Size Notes
driver-rt.jar 169.2

KB
platDataRecovery-rt.jar 122.3

KB
driver-ux.jar 47.7 KB platDataRecovery-wb.jar 37 KB

driver-wb.jar 106.8
KB

platMstp-rt.jar 33.2 KB

email-rt.jar 89.8 KB platPower-rt.jar 45.8 KB

email-ux.jar 33 KB platPower-wb.jar 28.3 KB

email-wb.jar 24.4 KB platSerial-rt.jar 23.3 KB

entityIo-rt.jar 21 KB platSerialQnx-rt.jar 22.4 KB

file-rt.jar 97.6 KB platform-rt.jar 905.2
KB

fonts-rt.jar 234.4
KB

platform-wb.jar 491.3
KB

fox-rt.jar 398.2
KB

program-rt.jar 89.5 KB

gx-rt.jar 129.6
KB

program-wb.jar 230.5
KB

gx-ux.jar 14.3 KB pxEditor-wb.jar 625 KB

gx-wb.jar 770.3
KB

query-rt.jar 51 KB

haystack-rt.jar 84.6 KB queryTable-wb.jar 141.9
KB

hierarchy-rt.jar 124.1
KB

report-rt.jar 66 KB

hierarchy-ux.jar 27.7 KB report-ux.jar 25.5 KB

hierarchy-wb.jar 16.8 KB report-wb.jar 103.3
KB

history-rt.jar 473 KB schedule-rt.jar 123.6
KB

history-ux.jar 56.9 KB schedule-ux.jar 155 KB

history-wb.jar 321.3
KB

schedule-wb.jar 252.1
KB

html-wb.jar 33.7 KB search-rt.jar 47.2 KB

hx-wb.jar 472.9
KB

search-ux.jar 60 KB

icons-ux.jar 692.8
KB

search-wb.jar 15.7 KB

jciAutoTagging.jar 80.2 KB New for FX
14.6

serial-rt.jar 23.3 KB

jciBacnetParser.jar 78.4 KB serial-wb.jar 9.9 KB
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Table 16: FX Workbench 14.x Modules

Module Name Size Notes Module Name Size Notes
jciCoreParser.jar 131.5

KB
silk-rt.jar 32.1 KB

jciDictionary.jar 407.5
KB

smartTableHx-wb.jar 283.7
KB

jciFxDriver.jar 388.7
KB

tagdictionary-rt.jar 163.2
KB

jciFxDriverApplianc
e.jar

549 KB tagdictionary-wb.jar 44.7 KB

jciFxDriverHx.jar 291 KB template-rt.jar 112.2
KB

jciMeters.jar 31.7 KB template-wb.jar 4354.7
KB

jcin2.jar 762.4
KB

themeLucid-ux.jar 949.4
KB

jciN2Parser.jar 164.4
KB

themeZebra-ux.jar 805.7
KB

jciSpaces.jar 186.7
KB

tunnel-rt.jar 63.4 KB

jciSupport.jar 171.3
KB

wbutil-wb.jar 538.6
KB

jciTagDictionary.jar 9.4 KB New for FX
14.6

weather-rt.jar 180.5
KB

jciTools.jar 30.5 KB weather-wb.jar 315.7
KB

jciViews.jar 107.8
KB

web-rt.jar 622.1
KB

jetty-rt.jar 76.4 KB webChart-rt.jar 31.6 KB

js-ux.jar 1728.8
KB

webChart-ux.jar 232.6
KB

jxBrowser-wb.jar 50 KB webEditors-ux.jar 884.9
KB

kitControl-rt.jar 296.9
KB

wiresheet-wb.jar 203.4
KB

kitControl-ux.jar 101 KB workbench-wb.jar 2510.3
KB

kitControl-wb.jar 11.9 kb
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